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1 Introduction 

1.1 What is LX Styler 

LX Styler is a customization tool for the LX8000, LX8080, LX9000, LX9050 and LX9070. It will 
help you to modify existing navigational pages or add new navigational pages. It will also 
help you to choose from more than 120 different data symbols to suit your needs. You can 
also change the shape and size of an airplane, a glider, or remove unnecessary elements. 
The following symbols will appear in this manual. 
 

 

Parts of the manual which should be read very carefully will appear with this 
symbol. 

 
This bulb icon will appear when a useful hint is given to the reader. 

 

1.2 System requirements 

The LX Styler is written for a Windows operating system. The minimum requirements are 
simple: 
• A Pentium processor 
• Windows Vista or higher 

• .NET Framework 4.6 
• 120 MB of free disk space 

1.3 Installing and uninstalling 

You can download the installation program from our webpage gliding.lxnav.com, then run it 
and follow the on-screen instructions to complete the installation. 
To uninstall a program, navigate to the "uninstall icon" in the LX Styler group, and run it. 
You can also open the "Control panel", select "Add or Remove Programs", find the LX Styler 
line, and press the Remove button. 

1.4 Starting the LX Styler 

After your successful installation, a program group named LX Styler is created, and an icon is 
placed on your desktop. Double click on the icon to run it. 

 

1.5 Contacting us 

In case you have difficulties understanding or running your LX Styler, or you discovered a 
bug, please send us an email to info@lxnav.com, or call us +386 592 33 400. 
Visit our webpage regularly for free updates and new help files. 

http://gliding.lxnav.com/
mailto:info@lxnav.com
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2 Getting Started 

2.1 LX Styler windows 

Once you start a program, the main window will show the last configuration that was 
opened, or it will be empty. 

 

The main window consists of a menu, a toolbar and a general view, where all the seven 
navigational modes are shown, namely airport mode, waypoint mode, task mode, statistics 
mode, setup mode, info mode, and near mode. 
You will notice that the last four modes are in shaded grey colour, which means that it is not 
possible to modify them. 
In each mode, all the relevant pages are displayed. If you click left twice on any navigational 
page, the "Navigation Page editor" will be opened. You can use it to define all small details 
of that selected page. 
There are more details about the "Navigation Page Editor" in chapters 2.4 and 3.2. 
 
 

 
 
 

Global properties 

List of 
symbols 

Property 
editor 

Navigational 
page 

Toolbar 
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2.2 Managing configurations 

We store the complete "look and feel" display of the navigational pages in a configuration file 
with an .lxprofile extension. You can create a new "Configuration file", or it can also be 
downloaded from the device. 
To download a "configuration file" from the device, enter the "Setup mode", and select the 
Profile and Pilots menu item. As the display is small, you have to press MORE>> to see other 
pages, until you see TO SD. Then press the TO SD button in order to copy the selected 
profile to the inserted SD card. 

  

You can now load stored configuration files in LX Styler through File->Open, or pressing the 
open icon in the toolbar. 
To create a new configuration, press File->New Configuration, or select a new configuration 
icon in the toolbar. 

 

The "configuration file" also consists of other essential settings for the device. 
Variometer setting, pilot information, files in use, and glider polar are also stored 
in the configuration file. One can also modify most of these settings with the LX 
Styler, but some settings can be changed only on the device itself. 
If you create a new profile, the whole setting will be set to default values, and 
you will have to modify them on the device. 

Once the configuration that suits your needs has been created, you can save it with File-
>Save, or by clicking the save icon in the toolbar. 

 

You can also test your configuration on the LX Sim, which you can find on 
gliding.lxnav.com. 

2.2.1 Protected profile 

You can protect profile with a pin. Protected profile can’t be opened or modified on the 
device without a pin. A prompt for opening an unprotected copy of the profile is shown when 
you enter a wrong pin while opening the profile on the device.  
  
Locker on the top right corner of the main window indicates the current protection status of 
the profile. You can modify pin for the profile with a single left click on a locker. Pin can only 
consist of numbers between 1 and 9. Setting empty pin will remove the protection. 

2.3 Managing navigational pages 

You can easily move, copy or remove any "Navigational page" with a mouse. A double left 
click on a selected navigation page will open the "Navigation Page Editor". Press the right 
button of the mouse, and a pop-up menu will open. 

http://gliding.lxnav.com/
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Select the appropriate menu item to add, remove, copy, or edit a page. You can also drag a 
page to another location – just press the left mouse button, and while holding it down, drag 
the selected navigational page to the desired location. A red line will indicate the new 
position of the page. Release the mouse button to place the page. 

2.4 Navigation Page Editor 

If you click left on any of the "navigational pages", or you select "Edit page" on the popup 
menu, a "Navigation Page Editor" will be opened. It is divided into four sections: 
• Toolbar, it contains all the symbols which can be put on a navigational page. 
• Global properties it defines the global styles for the symbols on it, and lists of all the 

symbols on the page. 
• Property editor, it displays all the properties of the selected symbols. 
• Graphical representation, shows the device and its navigational page. 
Select one or more items from a list, or pick them on the device screen. They will be 
highlighted on the list, and a blue rectangle will be drawn around them. "Property editor" will 
fill in the properties for the selected item. If more than one element is selected, "property 
editor" will show only the common properties. 

 

Once you have finished editing a page, press the "Apply button" in the toolbar to accept the 
changes, and return to the main window. Press "Cancel" to abandon all changes, and return 
to the main window. 

2.4.1 Toolbar 

Select a desired item from the toolbar to place it on page. Some items will be greyed if they 
are already on the page, or they are unavailable. 
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A Left click on an item will automatically place it in the top-left corner of the page. If you 
select Data Symbol, a new dialog will open in which you can then select the desired symbol. 

 

Data symbols are grouped in seven groups: aircraft parameters, outside parameters, target 
parameters, task parameters, optimization data, FES/JDU and misc tab. More details about 
the data symbols of each tab are available in chapter 3.2.2. 
 
You can also find appropriate symbol through search field. Search tab containing matched 
data symbols will appear while typing. 
 
The toolbar also displays, a delete button with which one can delete the currently selected 
item. You can also delete an item by pressing the delete key. 

2.4.2 Global Styles  

When you want to change the colour for all the symbols on the page in one move, you 
should use global styles. There are four different items in this category: 
• "Background colour" defines the background colour of a page. The default colour is 

black 
• "Title style" defines the font, the background colour, the border colour and the text 

colour of data symbol titles 
• "Data style" defines the font, the background colour, the border colour and the text 

colour of a data value 
• "Single line symbol style" defines the font, the background colour, the border colour and 

the text colour of single line data symbols. 
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If you change the colour or the font of any of the global styles, it will be applied 
only to the data symbols with the property “Use Global Style” set to yes. 

2.4.3 Symbols lists  

 
The "symbol list" shows all the elements of a page. A left click on an item selects it. It will 
highlight it, a blue rectangle will be drawn around it in a graphical view, and the properties 
for a selected item will appear in the "property editor". You can also select multiple elements 
at once by holding down the CTRL button, or select a range of elements using your SHIFT 
button. Once selected, you can change the common properties for all of them.   

2.4.4 Message overlay 

 
When "message overlay" is selected, a demo message will appear, and you will be able to 
edit its size, where it is located, and whether a Flarm radar is displayed next to it. There are 
three different messages, Warning, Critical and Info. The overlay for each of them can be 
edited separately. 

Symbol 
title  

Single line 
symbol 

Symbol 
data 
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2.4.5 Property editor 

The "property editor" shows all the properties of a selected element that can be modified. 
The "property editor" is a table with two columns. 

 

The left column displays the property name; and the right column displays the property 
value. Click on the property value to modify it. Press down the arrow on the right side, and 
an additional dialog for the selected property will be displayed. 

 

At the bottom of the "property editor", there are more detailed description for a selected 
item. 

2.4.6 Device Screen 

The "device screen" is a graphical representation of the "navigational page". 
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Point to a symbol and select it with a mouse left click. If you hold the left mouse button on a 
symbol, you can drag it around, and place it into the desired position. If you click, hold and 
move small white squares around a selection, you can resize the symbol. 
To select multiple symbols at once, hold down the Ctrl button on your keyboard, and then 
click on the next symbol you wish to select. Now, you can move or resize them together. To 
deselect it, click again on the selected item while holding Ctrl. 
When resizing or moving, the borders of a selected symbol are snapped to the borders of 
other symbols; this is indicated with an orange line. If you wish to move or resize a symbol, 
freely hold down the Shift key while moving the mouse. 
You can also move a selection by 1 screen pixel with the arrow keys of the keyboard. To 
move only the top-left corner, hold down Ctrl while pressing the arrow keys. To move only 
the right-bottom corner, hold down Shift while pressing the arrow keys. 

2.5 Checklists 

It is possible to open and create "checklist pages" with the LX Styler. Checklists are saved in 
file with a checklists extension. You can activate them on your device in Setup > Files and 
Transfer > Checklists. 
When editing a "checklists page", two additional buttons are present in the toolbar. The 
"check item button" inserts one checklist item on the page. These are special items that you 
can check, uncheck, and scroll on the device. 
 

 

The "checklist button" opens a new dialog where you can create multiple checklist items 
faster. After selecting the "Create button", the items are generated and added to the page. 
Now you can reposition them on the page, or make additional changes and change the style 
of individual rows. 
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After a checklist is created, you can still add other items to the checklist page. You do this 
the same way you would do it on a normal page.  

 

You can create more than one checklist page. To add additional pages, click on the left-hand 
side of the screen and select add. Here you can also remove, copy and paste pages or 
change the order in which they appear by dragging them up or down. 

 

 



LX Styler version 7.2   September 2019 

 Page 13 of 35 

3 Commands 

3.1 Main window 

The "Main window" commands are as follows; new configuration, new checklists, open or 
save, recent files, import and exit. Recent files are displayed only if some previous 
configurations were already opened. 
In the "Convert menu", there is a list of other devices that you can convert to the profile. iI 
you have a LX8000, and you want to use the same profile on the 9000... you have to press 
CONVERT, and select 9000. 
The "tools menu" consists of other useful features used to modify a profile. It is possible to 
edit settings, and change the order of the remote action buttons. 
In the "help menu", you can open a PDF manual to see the program version. 

3.1.1 New configuration 

 

When you select a "new configuration option", a dialog for device selection opens. Here you 
can select the device you want to create for navigational pages. For some devices, you have 
two options, which are portrait and landscape. After the selection is made, a new 
configuration is created with default navigational pages and default settings.  
 

 

The "configuration file" also consists of other settings essential for the device. 
Variometer setting, pilot information, files in use, and glider polar are also stored 
in the configuration file. Most of these settings can also be modified with the LX 
Styler, while others can only be changed on the device itself. 
If you create a new profile, all settings will be set to default values, and you will 
have to modify them on the device. 

3.1.2 New checklists 

When clicking on the "New configuration command", a device picker dialog will open. After 
selecting it, an "empty checklists editor" will be displayed with pages on left side, and a 
familiar page editor in centre. For more details about checklists, please refer to chapter 2.5 

3.1.3 Open 

The "Open option" opens an existing configuration file or checklists. If you have already used 
a program for editing, you can open some of the recently opened files from the list in the 
"File menu". 
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3.1.4 Save 

The "Save command" saves all current configurations, or checklists file. 

3.1.5 Import 

You can import pages from an existing open profile. You can manually select which modes 
and pages you want to import, or simply click select all. If you also wish to import all the 
setting saved in the profile (such as map settings, opened waypoints, units settings, sound 
and graphics settings…) then check the "Import all settings" option. 

 

3.1.6 Exit 

The "Exit command" will close the LX Styler. Make sure you saved your configuration before 
exiting the program. You may also exit the program by pressing the Alt+F4 key combination. 

3.1.7 Convert 

The "Convert command" opens current profiles for use on other devices. If there are any 
settings in profile, they are preserved. If the screen sizes are not the same on current and 
target device, the program will try to resize and move the symbols on all the pages to fit the 
target screen size. 

3.1.8 Profile editor 

You can access the "Profile Setting Editor" from the Tools menu. Once there, you can select 
one of the many profile groups, and then edit individual settings. 
You can only edit settings that the device has already saved to a profile file. So, if you just 
create a new profile in the LX Styler you cannot edit it because it doesn’t exist yet. 
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3.1.9 Remote actions editor 

From the "Tools menu", you can access the editor with which you can reorder navigation 
buttons for the remote stick. This customization is available for airport mode, waypoint mode 
and task mode. You can enable or disable the custom order of buttons in the mode by 
toggling the corresponding checkbox. When enabled, you can reorder the buttons by clicking 
and dragging them up or down inside the list. 

 

3.1.10 Edit page 

When you make a right click on a page, a popup menu will appear. Select the "Edit Page 
item", and then the "Navigation Page Editor" will open. 

3.1.11 Add page 

Select this option to add a blank page. A page can be added before selecting a page or after 
doing it. 

3.1.12 Remove page 

Select "Remove page" to delete a page. 

3.1.13 Copy page 

A page can also be copied. Select a page, and copy it to a local clipboard. Once a page is 
copied, it can be pasted. 
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3.1.14 Paste page or style 

This will create a copy of a page from the clipboard. It will be placed after the selected 
navigation page. You can also paste global styles from a copied page into a selected page. 

3.1.15 Set as thermal 

This will set the current selected page as the thermal page. When this feature is enabled on 
the device, the selected page will appear when circling. By default, the first page in every 
mode is set as the thermal page. 

3.1.16 Enable/disable mode 

If you do not need to use one, or more navigation modes, you can disable them by 
unchecking the checkbox in the mode header. 

3.1.17 Home mode 

Click on the "house icon" on the mode header bar to set it as the "home mode". When you 
start the device, the "Home mode" will open first. 
 

3.2 Navigational Page Editor 

The "Navigation Page Editor" is divided into four major sections.  
• "Toolbar" contains all the symbols which can be put on a navigational page. 

• "Global properties" defines the global colours for the page symbols; below it, there is 
a list of all the symbols on the page 

• "Property editor” is used to display the properties of the selected symbols 
• "Graphical representation" is for the device and the navigational page. 

3.2.1 Toolbar 

 

The toolbar contains the different symbols which can be placed on a navigational page. Most 
symbols can be placed only once on a page, and will be disabled if they are already on that 
page. 
Some of the symbols can be placed on a page only in combination with others, and will be 
disabled if a symbol is missing. (e.g.: a zoom symbol can be placed on a page only if the 
map and the aircraft symbols are already on the page.) 
When you click on the data symbol selector, a dialog will open. 
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Data symbols are grouped in seven logical groups: aircraft parameters, outside parameters, 
target parameters, task parameters, optimization data, FES/JDU and misc tab. Specific 
symbols will be depicted in the next chapter. 
On the toolbar, you will also find a delete button used to remove a symbol from a page, and 
the buttons "Apply and Cancel" to exit from the editor. 

3.2.2 Symbols 

Map symbol 

You can add a map to a page. By default, it will be stretched to the whole screen. Select 
edge points to resize it, or to move it around.  A Map symbol is always added along with the 
aircraft symbol. 

Aircraft symbol 

The "aircraft symbol" shows the current position of the aircraft on the map. The aircraft 
symbol will automatically be added to the map. 
You will notice that there are two aircraft symbols shown. The one drawn as a shadow  
shows the  position of an airplane when "Track Up", "Goal Up" or "Heading Up" map 
orientation is selected on the device (See the manual of the device for more details about 
map orientation). In the "property editor", this position is referred as "Track" and the other 
position is referred as "North". There are several types of aircraft available. Change the style 
to select different aircraft symbol.  
You can also show a wind vector, which will rotate around the symbol. 

 

3D Map 

A symbol shows the map with a 3D terrain. This feature is not available on some older 
LX8000 and LX9000 devices. 
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Battery 

Battery will display visually the current level of the battery. Green indicates that the battery 
is ok. It will first turn yellow, and later on red, when the battery is empty. 

Orientation symbol 

The "Orientation symbol" always points towards the true north. It can be placed on a page 
only when the map symbol is already on that page. 

Final glide symbol 

The "Final glide symbol" is very complex symbol, and you are highly recommended to have it 
on the page. It will display the current MacCready value, the arrival altitude at goal, and 
many other features which are very important to start the whole task procedure. 
If you fly a SGP task there is a special symbol next to the FG. For more details, please refer 
to the device manual. 

Wind symbol 

The "Wind symbol" shows the wind direction. It is useful to combine it with the wind data 
symbol in order to get the wind strength. While circling you can have the thermal assistant 
around the wind symbol. Enable or disable this feature with the “Has Thermal” property. 

GPS symbol 

The "GPS symbol" shows the status of the GPS. A green colour indicates that the GPS is 
acquiring a 3D position; a yellow colour stands for a 2D position fix. When the colour is red, 
no position is calculated by the GPS. Each bar represents two visible satellites. 

Zoom symbol 

The "Zoom symbol" shows the current map zoom. You can use it only when the "map 
symbol" is already on the page. The zoom can be presented in two ways : a number on the 
symbol indicates the length of the zoom symbol, or a number indicates its length in the 
whole screen. Use the “Full” property to switch between the two different styles of the 
symbol. 

AHRS symbol 

This symbol will display an artificial horizon. You can also set it to see the compass direction. 
It is available in 3 different "display styles", circle, round, or rect. 

Radar symbol 

The "Flarm radar symbol" will display a radar screen showing Flarm targets at a predefined 
zoom. If, on the device, there is no map symbol on the page, you can also change the visible 
range with the ZOOM button wheel. 

Altitude tape symbol 

It shows the altitude band with the current altitude in the middle. You can customize it to 
see different information on the top and the bottom of the symbol. These data are QNH, 
MSL, height above ground, and flight level. 

Airspeed tape symbol 

It shows the current aircraft indicated speed. You can fully customize the band colours to 
match your aircraft speeds. You can also set it to display true airspeed, groundspeed, or 
outside temperature. 
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Flaps tape symbol 

It displays the current and the required flaps position. You can centre on any of these two 
positions, or you can display the full tape range. In this case, all the flaps position ranges are 
spaced equally, regardless of their values. In "Tape colour", you can edit the colours of every 
even and every odd flap position, and the colour of the current flaps position. 

History view symbol 

This shows the past aircraft altitude, and terrain elevation. Circling direction is also visible. 
You can specify how many minutes of flight should be shown with "Shown Minutes 
property". The value by default is zero, which shows the history of the whole flight. 

Side view symbol 

This one symbol shows the lateral view of your position toward a selected goal, or aircrafts 
bearing. It also displays airspaces on your way, which you can customize on the device 
inside the "Airspace graphics dialog" in the setup mode. 

Wind profile symbol 

This symbol displays information about the wind profile. It is very similar to the tape in the 
"Wind dialog". 

Picture symbol 

This symbol displays photos tied to selected waypoints or airports. You can edit these 
pictures with "LX Asapt editor" which you can find on gliding.lxnav.com. 

Compass and HSI symbols 

These two symbols display the magnetic rose. The compass is always attached to a plane 
symbol, and can be added only when the map symbol is already on the page. The HSI 
symbol can be added and moved freely at any time. The "compass tape" is another symbol 
with similar functionalities that always centres on the plane heading.  

Wi-Fi symbol 

This shows the status of your Wi-Fi connection. Note that Wi-Fi functionality does not work 
on some older LX8000 devices with serial number 25001-25699, or 28000-28199. 

Vario symbols 

The "vario gauge" is a representation of the variometer. You can change which values the 
needle is pointing to." The Vario tape symbol" shows a vario value on the vertical tape. 
There is also a separate "SC Vario indicator" that displays the current vario mode. 

Thermal symbol 

This is a thermals graph from the "Statistics mode" in a symbol form. It displays the last four 
thermals. The thermal average is shown below each thermal column.  Thermals are coloured 
according to the MacCready value.  A red colour means that the thermal average was 
0.5 m/s or more, above the current MacCready setting. A blue colour means that the thermal 
average was 0.5 m/s or less, below the current MacCready setting.  An orange colour 
indicates that the thermal average matches the Mac Ready setting. 
On the left side, there is an altitude scale.  On the right side, there is a display of the 
average of the last four thermals. 

http://gliding.lxnav.com/
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Gauges symbol 

Here, you can find a gauge of the current g-load value. It also shows the lowest and 
highest recorded values. You can set it to be visible only when it is over a certain g-load. 
FES Gauges is a set of gauges designed for glider equipped with FES system. One can find 
the following gauges: Voltage, minimum Voltage, maximum Voltage, Current, 
Power, RPM, Throttle, Engine temperature, Controller temperature, Battery 
temperature and Battery level. 

Meteogram  

This symbol shows all weather information for a selected target. It requires a Wi-Fi 
connection in order to download the image. Note that Meteogram does not work on some 
older LX8000 devices with serial number 25001-25699 or 28000-28199. 

FLARM Indicator 

The indicator shows the direction and the vertical position of other aircrafts.  
 

 

Values written in data symbols inside the LX Styler are totally useless, and are not 
correlated to each other. These values, in DEMO are only for demonstration 
purposes. 

Forecast legend 

This symbol represents a generic legend for forecast map layers. The type of data the 
symbol actually displays depends on the forecast service used (e.g. rainfall amount). You can 
only add this symbol if the page contains a map. 

Data symbols 

There is variety of data symbols available. A "data symbol" is a numerical representation of 
different parameters. A data symbol consists of a title field, which stores the name of a data 
symbol, and a data field which is shown as the parameter. The title can be omitted if the 
"Show title property" is set to No. When the „Use Global Style” property is set to Yes, the 
data symbol will follow the global page style properties. Disabling the „Use Global Style” 
property allows the full customization of a selected data symbol. 
There are more than 120 different data symbols. They are grouped into seven groups. 
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Aircrafts parameters 
Title Description 

Vario Current vertical speed 

VarA Averaged vertical speed (the average time can be set on the device) 

Thermal Last thermal vertical speed 

Netto Current netto vertical speed 

Alt Altitude above MSL 

AltIGC Altitude from the IGC pressure sensor 

RawIGC Raw IGC altitude 

AltGps GPS Altitude  

Gnd Terrain elevation 

Agl Height above the ground 

Height Height above takeoff 

FL Flight level 

FlIGC Flight IGC altitude 

GS Groundspeed 

TAS True airspeed 

STF Speed to fly 

reqSTF Speed to fly for a required MacCready (used for Pirker final glide) 

Trk Ground track 

Hdg Heading 

E Current glide ratio 

Th.E Thermal glide ratio 

Emc MacCready glide ratio 

Mc Sets MacCready value 

Time Local time 

Date Local date 

UTC Time Current UTC time 

LON/LAT Current longitude and latitude position 

Battery Battery voltage 

IAS Indicated airspeed 

thE Theoretical glide ratio 

VarioFL Average vario for the flight 

AltGain Gained altitude in a thermal 

reqFlaps Requested flaps position 

curFlaps Current flaps position 

g-load Current g-load 

g-min Minimum g-load 

g-max Maximum g-load 

Circ.Flt Flight circling 

Circ.Tsk Task circling 

Circ.60 Circling in the last 60 minutes 

Sp.60’ Last 60 minutes speed 
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FltTime Time of flight 

Ballast Current ballast 

Radius  Circling radius 

revT Circling revolution time 

Avg.sp Average speed 

XC sp XC speed 

 
FES/JDU 
Batt.Left[min] Displays the remaining battery level in minutes 

Batt.Left[%] Displays the remaining battery level in percent 

 
Misc 
Title Description 

Label An arbitrary text label. You can type any text you favour in there. 

Location name Nearest location 

Airspace name Distance to the nearest airspace 

Airport name Nearest airport 

Wpt. name Nearest waypoint 

tmDist Team partner distance 

tmBrg Team partner bearing 

tmVario Team partner vario 

tmAlt Team partner altitude 

tmName Team partner name 

tmRelAlt Relative altitude of the teammate 

tmTo Relative bearing of the teammate 

tmCode Team code of your position 

tmWptCode Waypoint team code 

Eng.TT Engine total time 

Eng.FT Engine flight time 

Flarm Flarm RXTX 

COM Active Frequency 

STBY Passive Frequency 

XPDR XPDR Transponder 

Rain Status Rain data status 

Rain Age Age of the displayed rain image 

TkOff Take off time 

Weather Info Timing information about active weather layers 

 
Optimization data 
Title Description 

Opt Optimized distance 

OptHome Optimized distance to home 

Tri Optimized FAI triangle distance 

OLC.Sp.60’ OLC 60 minutes speed 

OLC.Sp OLC speed 

Sp.150’ Last 150 minutes speed 

Alt.150’ Altitude 150 minutes ago 
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Outside parameters 
Title Description 

Wind Current wind with its direction and strength 

cWind Head/Tail wind component. There are two values displayed. The first is a 
calculation based on track and wind direction; the second is the 
difference between TAS and GS. 

WindX Side wind component. It displays its strength and direction. 

OAT Outside temperature 

Humidity Relative humidity. (A special sensor must be attached to the device) 

Dew.Temp Dewpoint temperature. (A special sensor must be attached to the device) 

Pot.Temp Potential temperature 

 
Target parameters 
Title Description 

Dis Distance to target 

Arrival Arrival altitude at target 

ArrMc0 Arrival altitude at target with the MacCready setting at 0 

ReqAlt Required altitude to reach the target 

Brg Bearing to target 

Radial Radial from target 

To Steering course to target 

ETA Estimated time of arrival 

ETE Established time en route 

reqE Required glide ratio to target 

Target Target name 

Req.Mc Required MacCready value to target, taking into account the wind. 

Elevation Target elevation 

Rwy.Dir Target runway direction 

Rwy.Len Target runway length 

Frequency Target frequency 

Sunrise & 
Sunset 

Sunrise and sunset times at the target location 

Description Additional description of target 

METAR Raw or parsed target METAR data 

TAF Raw or parsed target TAF data 

toWind Head/tail wind to the target. There are two values. The first is a 
calculation based on the bearing and the wind direction, and the second 
is the difference between TAS and GS. 

Code Target code 

VMG Velocity made good 

 
Task parameters 
Title Description 

tDis Remaining task distance 

tMinDis Minimum task distance 

tMaxDis Maximum task distance 

Fin.Elev Task finish elevation 

tArr Arrival altitude on task finish calculated through all remaining task points 

tArrMc0 Arrival altitude on task finish calculated through all remaining task points 
with MacCready set to 0 



LX Styler version 7.2   September 2019 

 Page 24 of 35 

tETA Task estimated time of arrival 

tETE Task established time 

tRemain Task remaining time 

tDelta Task delta time. A difference between tETA and tRemain 

tskE Required task glide ratio 

Tsk.Sp Task speed so far 

tReq.Sp Task required speed calculated from tRemain and tDis 

tSp.60’ Task speed for the last 60 minutes 

tReq.Mc Required MacCready value towards the next task point, taking into 
account the wind. 

trqSTF Required "speed to fly" calculated from the required MacCready 

T.Start Alt Task start altitude 

xTrk Current leg cross track distance 

tVario Average vario for task 

sDis Distance to zone centre 

sBrg Bearing to zone centre 

xsDist Cross distance to zone centre 

tunAlt Task uncompensated arrival altitude 

3.2.3 Message symbol 

This is a "special symbol" which represents notifications visible on your device. You can’t 
change a symbol for each page separately, but only for every mode (airport, waypoint and 
task). It is displayed after you select it from a list of symbols. It is now possible to resize and 
move the symbol. If you want to hide the message symbol, you need to deselect it, or select 
some other symbol from the list on the left side. 

3.2.4 Colour editor 

The "colour editor" is used to define a colour for a selected property. The "colour dialog" will 
open if you click on the down arrow in the "property value cell". 

 

The colour can be selected from a grid of predefined colours on the left side of the dialog. Or 
you may change red, green and blue values with sliders, or enter numerical values. The 
colour can also be set with hexadecimal values. 
 
It is also possible to define the opacity for a selected colour. Slide the opacity slider towards 
zero to make a selected property transparent. 

3.2.5 Font Style 

If you click on the "font style property", a "font style dialog" will open. 
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You can select different font styles there as well as an optional text outline. 

3.2.6 Text Alignment 

The "text alignment popup dialog" is used to define how the text is aligned horizontally and 
vertically inside a symbol. 

 

3.2.7 Ranges  

Items like G-meter and Data symbol can use "ranges" for their display. With the "ranges 
editor", you can modify their appearance when the "symbol value" changes. 
In the centre, there are series of value and colour controls. Edit "value" to constrain ranges, 
and select "colour" to change the appearance of a range. On some symbols, a text can start 

blinking when the value enters a specified range. Press on the “ ” button after a colour 
selector on ranges to specify where you want the blinking to occur. The preview of ranges is 
displayed on the left side of the list.  

 

You can add a new range, or remove it with the "+ and – buttons" on the bottom left. After 
pressing the button, hoover over the tape on the left side, and click on the range to remove 
it, or split it in two. If you press "add new", you can also select the up or down arrow to add 
a new range on the top, or on the bottom of the scale. On the bottom right side, it is 
possible to select the unit in which the values will be written. 

 

If the "range previews" are drawn in diagonal lines while editing, it means that 
the written values are invalid, or are not defined in an ascending order. 
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4 LXNAV Connect Integration 

LX Styler supports uploading and downloading of lx profiles and checklists from your LXNAV 
Connect data services.  
 
To use any of the functionality offered by LXNAV Connect from LX Styler, you must be 

signed in into your Connect account, you can do this by clicking on the “ ” button in the 
top right corner of the Main window, if your name displays alongside it, that means you are 
already singed-in. You can also ignore this step and LX Styler will prompt you for your 
credentials once required. 
 

 
 
In order to log out of your account, press the same button again and a menu will appear, 
click the “Log out” menu item. 

4.1 Uploading files 

To upload your currently opened checklists or lx profile either click the “ ” button in the 
toolbar, or go to the “File” menu in the main window, select “LXNAV Connect” and then click 
“Upload”. If you aren’t logged into your Connect account already you will be prompted to do 
so. 
 
Choosing services 
Next you will be prompted to select what services to upload the file to. You select a service 
by clicking its checkbox. The file will only be uploaded to the selected services. To continue 
click “OK”, to cancel the upload click “Cancel”. 
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Please note that if a service is greyed out, this is either because the service is 
unavailable, discontinued, an error occurred or you simply aren’t singed into it. 
You can solve the latter by going to your LXNAV Connect Dashboard and singing 
in with that service. 

 
File name 
The name of the file will be the same as it is displayed in LX Styler. 
If one or more of the services you selected already has a file with the same name in the 
“profiles” folder, you will be prompted what to do. 
 

 
 
You may choose a different name for the file to be uploaded, overwrite the files with the 
same name, or cancel the upload. 
 
Tracking Progress 
You can track the progress of the upload by looking at the status bar that appears on the 
bottom of the main window. 
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When the upload completes for all of your selected services, you will be notified. If uploading 
to any service failed you will be shown the details of the error. 
 

 
 

4.2 Downloading Files 

You can download files from your own data services by clicking on the “ ” button in the top 
right corner, or by clicking on “File” menu then selecting “LXNAV Connect” and finally 
“Download”. A new window will appear listing your services on the left. You can view files on 
a service by clicking its row, after that LX Styler will query the service and display the files on 
the right side. You then download a file by selecting it and clicking the “Download” button or 
simply by double clicking the row. Once the download completes, the download window will 
close and your file will be opened for editing. 
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You can cancel the download before it completes by clicking the “Cancel” button. 
 

4.3 Automatic file synchronization 

Files downloaded from your LXNAV Connect services can be automatically synchronized with 
LX Styler. Meaning whenever you open a file you downloaded from LXNAV Connect you get 
a warning if the remote file has changed, and when you close LX Styler it will automatically 
update the remote file for you. 
 
In order to enable this feature, open the “Settings” menu and make sure “Automatically 
synchronize edited profiles to my private storage via LXNAV Connect” is checked. You can 
toggle the option by clicking on it.  
 

 
 
When you open a file with enabled synchronization, LX Styler will check if the remote file has 
changed, and if the file you just opened has been modified outside of LX Styler. In case only 
one of the files was modified, the one that was modified will be loaded, if both we’re 
modified you will be prompted which one you would like to load. 
 

 

 

Please note that if a service appears greyed out, this is either because the service 
is unavailable, discontinued or you simply aren’t singed into it. You can solve the 
latter by going to your LXNAV Connect Dashboard and singing in with that 
service. 
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5 Profile Collection Integration 

LX Styler also supports uploading to LXNAV Profile Collection, where pilots may upload their 
profiles in order to share them with the rest of the world. 

5.1 Upload modes 

Both manual and automatic uploading of profiles to Profile Collection is supported. 
 
When uploading in either mode you will be prompted to sing in to your LXNAV Connect 
account (if not already singed in) before the upload begins. Your name will also appear 
alongside the uploaded profile. 

5.2 Settings 

To change the current settings, select “Settings”, then click on “Automatically upload my 
profiles to LXNAV Profile Collection (public)”. If the option is checked, LX Styler will 
automatically upload the open profile when you save it. 
 

 

5.3 Uploading 

To upload your profile, click on the “ ” button, or go to the “File” menu, select “Profile 
Collection” and then click “Upload”. If you aren’t singed into your LXNAV Connect Account 
you will be prompted to do so. Then you will be prompted to name your profile once you 
have done that the upload will begin. 
 
If automatic mode is enabled, then the application will automatically upload your profile to 
Profile Collection when you save it on your local computer. 

5.4 Browsing 

To open the Profile Collection web page, click on the “ ” button in the toolbar, or go to the 
“File” menu, then “Profile Collection” and finally click “Browse”. The web page should open in 
your default web browser. 
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6 Updating LX Styler  

Every time LX Styler starts it will automatically check for a newer version. If a newer version 
is available, you will be prompted to install it. If you choose to do so, the application will 
close and installation will automatically begin. 
 
It’s also possible to manually check for updates, you do this by selecting the “help” menu in 
the main window and clicking the “Check for updates” option. 
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7 Polar designer 

Polar designer is a tool for calculating glider polar parameters. Additionally, you can enter 
glider name and other characteristics of a glider - competition class, max. weight, etc. Polar 
parameters with the glider characteristics can be automatically added to the existing profile 
or manually inserted in the device. 
 
You can access the "Profile designer" from the Tools menu from the Main window. 
 
 
 

 

 

7.1 Getting Started 

You can enter a new glider or select a glider from a preset glider list. Polar parameters will 
be calculated, when there are at least three points inserted on the grid. With the additional 
points you can refine the resulted polar. 
 
Points can be inserted via Points editor or with a single left click directly on the Grid. Single 
right click on the point will remove the point. You can also move points by moving the 
mouse while pressing the left button. 
 
A good practice is to load a polar image to the Grid. Through toolbar you can modify the 
image to exactly align the horizontal and vertical coordinates. Coordinates must be exactly 
aligned with the image in order to get the accurate results. In Property editor you can 
change each coordinate unit and range. Add a few points to exactly match the polar line in 
the image. 
 

Grid 

Property 
editor 

Points 
editor 

Toolbar 
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7.2 Commands 

7.2.1 New Document  

You can reset all changes by clicking on the "New document" command. If unsaved changes 
exist, the prompt for saving the current settings to an lxpolar file will be shown. 

7.2.2 Open Polar  

All previously saved settings can be loaded from the lxpolar file with the "Open polar"  
command. 

7.2.3 Save  

The "Save"  command saves the current settings including polar image to an lxprofile file. 

7.2.4 Open image  

With the "Open image"  command you can load an image to the grid as a helping tool for 
defining a polar. 

7.2.5 Exit 

The “Exit” command closes the polar designer tool. If unsaved changes exist, the prompt for 
saving the current settings to an lxprofile file will be shown. All glider parameters will be 
automatically stored to a profile, if a glider exists in the profile. 

7.2.6 Show Grid 

Clicking on the "Show gird"  command will toggle between hiding and showing the grid 
lines. 
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7.2.7 Select Image 

When clicking on the "Select image"  command enables or disables the image selection 
tool. You should align each image corner with the coordinates and then press Crop Image. 

7.2.8 Crop Image 

The "Crop image"  command crops image according to the selected image corners. 

7.2.9 Rotate Image Right 90°  

Click on the "Rotate Image Right 90°"  command to rotate the image clockwise. 

7.2.10 Rotate Image Left 90°  

Command "Rotate Image Left 90°"  rotates polar image counter clockwise. 

7.2.11 Flip Image Vertical 

Command "Flip Image Vertical"  flips image vertically. 

7.2.12 Flip Image Horizontal 

Command "Flip Image Horizontal"  flips image horizontally. 
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